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Polycom® and the logo designs  
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Are trademarks and registered trademarks of 
Polycom, Inc. in the United States of America 
and various countries. All other trademarks 
used herein are the property of their respective 
owners. 

Patent Information 
The accompanying product is protected by one 
or more US and foreign patents and/or pending 
patent applications held by Polycom, Inc. 

Copyright Notice 
Copyright © 2007 to 2008 Polycom, Inc.  

All rights reserved under the International and 
pan-American copyright Conventions.  

No part of this manual, or the software 
described herein, may be reproduced or 
transmitted in any form or by any means, or 
translated into another language or format, in 
whole or in part, without the express written 
permission of Polycom, Inc. 

Do not remove (or allow any third party to 
remove) any product identification, copyright or 
other notices. 

Every effort has been made to ensure that the 
information in this document is accurate. 
Polycom, Inc. is not responsible for printing or 
clerical errors. Information in this document is 
subject to change without notice and does not 
represent a commitment on the part of Polycom, 
Inc.  

Notice 
Polycom, Inc. has prepared this document for 
use by Polycom personnel and customers. The 
drawings and specifications contained herein 
are the property of Polycom and shall be neither 
reproduced in whole or in part without the prior 
written approval of Polycom, nor be implied to 
grant any license to make, use, or sell equipment 
manufactured in accordance herewith. 

Polycom reserves the right to make changes in 
specifications and other information contained 
in this document without prior notice, and the 
reader should in all cases consult Polycom to 
determine whether any such changes have been 
made. 

No representation or other affirmation of fact 
contained in this document including but not 
limited to statements regarding capacity, 
response-time performance, suitability for use, 
or performance of products described herein 
shall be deemed to be a warranty by Polycom 
for any purpose, or give rise to any liability of 
Polycom whatsoever. 

Contact Information 
Please contact your Polycom Authorized 
Reseller for assistance. 

Polycom, Inc. 
4750 Willow Road,  
Pleasanton, CA 94588 
http://www.polycom.com
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About this Guide 
This document explains how to set up the SpectraLink Configuration 
Cradle, create configuration plans for the SpectraLink 8002, 
e340/h340/i640 Wireless Telephones and how to download 
configuration plans to the handset. It also covers maintaining the 
software and troubleshooting error messages. 

Referenced Documents 
SpectraLink e340/h340/i640 Wireless Telephone: Configuration and 
Administration Guide (SRP) (72-1065-09) 

SpectraLink e340/h340/i640 Wireless Telephone: Configuration and 
Administration Guide with Cisco CallManager/CallManager Express  
(72-1082-02) 
SpectraLink e340/h340/i640 Wireless Telephone: Configuration and 
Administration Guide with Mitel Networks 3300 and SX-200 ICP  
(72-1084-02) 

Above documents are available at 
http://www.polycom.com/usa/en/support/voice/wi-fi/wi-fi.html. 

Customer Support 
Polycom wants you to have a successful installation. If you have 
questions please contact Polycom Customer Support Hotline at  
(800) 775-5330. The hotline is open Monday through Friday,  
6 a.m. to 6 p.m. Mountain Time. 

For Technical Support: technicalsupport@polycom.com 

For Knowledge Base:  
http://www.polycom.com/usa/en/support/voice/voice.html 

http://www.polycom.com/usa/en/support/voice/wi-fi/wi-fi.html�
mailto:technicalsupport@polycom.com�
http://www.polycom.com/usa/en/support/voice/voice.html�
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Icons and Conventions 
This manual uses the following icons and conventions. 

 
Caution! Follow these instructions carefully to avoid danger. 

 

 
Note these instructions carefully. 

 

Label This typeface indicates a key, label, or button on SpectraLink 
hardware. 
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SpectraLink Configuration Cradle 
Overview 

The SpectraLink Configuration Cradle is a two-slot cradle designed to 
automate the process of configuring the 8002, e340, h340 and i640 
models of SpectraLink 8000 Wireless Telephone. The front slot of the 
cradle is for the SpectraLink 8002, e340/h340 Wireless Telephone; the 
rear slot is for the SpectraLink i640 Wireless Telephone. Only one 
handset may be configured at a time. 

 
The Configuration Cradle can also aid in debugging system 
problems. See Chapter 8 Assert Errors. 

The Configuration Cradle is connected to a PC via a serial cable. The 
Configuration Cradle program runs on the PC and enables the system 
administrator to establish and store configuration options for System, 
Group and User levels. The Configuration Cradle program can be 
downloaded from the Polycom website 
http://www.polycom.com/usa/en/support/voice/wi-
fi/dual_charging_stand.html 

Configuration plans may be set up in the program and downloaded 
into a Wireless Telephone or a configured Wireless Telephone may be 
placed in the cradle and its configuration may be uploaded and edited 
or saved. 
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SpectraLink Configuration Cradle with SpectraLink e340 Wireless Telephone 
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Installing the SpectraLink 
Configuration Cradle 

Set up the Configuration Cradle by first obtaining the appropriate 
SpectraLink power supply for your country or region. Place the 
Configuration Cradle on a flat, horizontal surface and plug the power 
supply into the Configuration Cradle and into an appropriate wall 
outlet. Plug a straight-through serial cable into the Configuration 
Cradle and into an available serial port on the PC. 

Set up a folder for Wireless Telephone configuration on the PC and 
download the programming software from the Polycom website 
http://www.polycom.com/usa/en/support/voice/wi-
fi/dual_charging_stand.html into this folder. Extract the individual 
files from the zip and run the PhoneConfig.exe file. 

Note that there is no installer or uninstaller since the program does 
not modify your system or registry. It runs from its current location 
and stores its settings locally. 

Serial port settings are handled automatically by the Configuration 
Cradle software. If necessary, the COM port the Cradle is using can be 
set in the Settings menu. 

 
USB Serial Adapters: Some adapters are incompatible with the 
Configuration Cradle. Of the adapters tested by Polycom 
engineering, two have been found to work: 

• Sakar International IConcepts Item #60448  

• Keyspan USA-19HS 
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Planning the Configuration Files 
Each configurable option may be categorized as one of three types: 
System (Sys), Group (Grp) or User (Usr). System level options should 
be those that are stable across the entire system. DHCP vs. Static IP 
addressing would be an example of a System option. Options that are 
designated as Group type should be those that change by category of 
user. PTT Allow/Disallow and PTT Channel are examples. A unique 
extension number is assigned to each handset by the system 
administrator and would be a User type. The remaining User types 
should be reserved for options that are normally set by the end user. 
For Standby menu options such as Ring Type and Noise Mode, 
default values may be entered with the expectation that the user may 
change them. 

Typical Configuration Plans 
Because the specific options that are available depend on the software 
version and License Option, the typical plan options for your facility 
may be different than those listed here. 

Typical System file settings: 

System file settings typically do not change across an installation. 
These are typical Sys categories: 

• License Option 

• Network Config 

• IP Addressing 

• ESSID 

• Security 

Typical Group file settings: 

If certain groups of people require different access to functions, such 
as push to talk, these options would be stored as Group files. Several 
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different Group files can be established and the handsets can be 
configured by group. Typical Grp categories are: 

• Push-to-talk options on both Admin and Standby menus 

Typical User file settings: 

If a setting can be changed by the user in the Standby menu, then it 
would typically be stored in a User file. These can be the default 
settings or whatever your system requires. Typical Usr categories are: 

• Extension 

• Static IP address 

• Ring Options 

• Phone Options 

 
You may have zones in your facility that require different System 
settings, such as security. These settings can be moved to a Group 
file or you may set up two System files. 
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Configuration Cradle Window 
When first opened, the PhoneConfig program displays the toolbar and 
a list of configurable options. All Editable settings fields are blank or are 
set to default values. Phone settings are unavailable until a handset is 
read or settings are copied to the Phone settings fields. 

Initial window 

A window similar to the one shown below appears when the Config 
Cradle program is first opened. The default filenames appear in the 
toolbar and all category radio buttons default to Usr. 
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Configuration Cradle Toolbar 
The Config Cradle toolbar allows you to name, open, and save 
configuration files and download and upload configuration settings 
to and from the handset in the Cradle. 

 

 

 

 

File management 

The three filename windows, System, Group and User match the three 
columns of radio buttons along the left side of the window. The Sys, 
Grp and Usr radio buttons allow you to designate the option(s) for 
System, Group or User files. The three windows in the file 
management section allow you to name, open, or save setting types as 
separate files.  

The filenames shown above are the default names, but any filename 
can be assigned by entering it into the field and clicking the Save 
button. By default, the files will be saved in a new folder named 
ConfigData under the folder where the program is stored. The new 
folder will be created automatically the first time a file is saved. To 
open an existing file, click the Open button and browse to the file. Use 
the File menu to customize the file structure, if desired. 

The three flags beside the Save buttons have four colors to indicate the 
status of the file displayed in the window: 

• Red: file does not exist. The filename in the window has not been 
saved. 

• Yellow: file not loaded. The filename in the window exists in the 
ConfigData folder but has not been loaded into the Editable settings. 

• Green: unsaved edits. When changes are made in the Editable 
settings field(s) the green flag indicates these have not been saved. 

• Gray: file up to date. The settings have been saved. 

File management Copy settings Upload/download and indicators



Configuration Cradle Window  
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Copy settings 

The Copy settings arrows and checkboxes allow you to copy between 
the Phone settings column and the Editable settings column. The Sys Grp 
Usr check boxes allow you to copy just the settings you require. 

Upload/download and indicators 

When the Read Phone and Write Phone buttons are clicked, they initiate 
the transfer of configuration data from or to the handset in the Cradle. 
The handset indicators change color to indicate the state of the 
transfer. See below for indicator color significance. The Stop button 
will halt the transfer. 

The Serial and MAC windows display the serial number and MAC 
address of the handset in the Cradle. This information is not stored.  

The four labeled flags on the right indicate the status of the 
configuration transfer: 

Active: green when attempting communication with handset in Cradle. 
Turns yellow if a timeout occurs (may be due to an improperly seated 
handset).  The software will repeatedly re-attempt communication 
after a timeout so re-seating the handset should correct the problem. 

Read: green when information is currently being read from the 
handset in the Cradle. 

Write: yellow when information is currently being written to the 
handset in the Cradle. 

Error: red when an error has occurred. An error message will appear 
on the status bar at the bottom of the main window. 
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Creating Your Configuration Plan 
Although not necessary for using the Config Cradle program, a 
configuration plan can maximize its efficiency and save countless 
hours of handset option management.  

Organize the plan 

Determine which options should be categorized as each type – 
System, Group or User.  

 
Do not create a plan that saves an option in two different 
categories. Option categories should be established and should not 
overlap. Example: Speakerphone and Push-to-talk settings 
(SpectraLink i640 handset only) are typically tagged as Grp options 
and saved as Group files. 

Create the options and save the settings 

Once you have established which options will be categorized as 
System, Group or User, enter the configuration information into the 
Editable settings fields.  

Start with the System options and enter all system-level field values, 
such as IP addresses, security, and reg domain. Click the Sys radio 
button on the left side of the window for each option. Save these 
settings as a System file by entering a descriptive filename in the 
System filename field and clicking Save. See the example below. 

 
Note that when a setting is changed, the option label is highlighted 
in yellow until it is saved. 

In the same way, create each Group plan by entering the values in the 
fields designated as Group types. Click the Grp radio button on the 
left side of the window for each option. Save each plan under a 
different name in the Group filename field. You may have several 
groups – possibly divided by sets of PTT users. 

It is recommended that you establish one generic User file that has the 
default (or desired) values for each User field. Click the Usr radio 
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button on the left side of the window for each option and save the 
generic user file. 

If desired, user settings can be saved for each user, as each handset is 
configured. If you determine that each handset configuration should 
be saved, it is easiest to do this during the configuration process. See 
Downloading a configuration plan to a handset, below. 

Alternately, you can upload options from a correctly-configured 
handset; copy them to the Editable settings column, categorize them and 
save them. See Uploading a configuration plan from a handset below. 

Sample Configuration Window 
Shown on the next page is a typical Static IP configuration using the 
WEP security method. All push to talk (PTT) settings are saved as a 
group. The settings in the Editable settings field were first uploaded 
from a configured handset and then copied from Phone settings. 



Creating Your Configuration Plan  
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Configuration Planning Worksheet 

Plan category____________________________   Filename______________________________ 

Sys Grp Usr Label Editable Setting 
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Downloading and Uploading 
Configuration Plans 

Once your configuration plans are established, the settings are easily 
downloaded into the handsets. 

Downloading a configuration plan to a handset 

1. Place a SpectraLink Wireless Telephone with the Battery Pack 
removed into the appropriate slot.  

2. Use the Open button located in the file management section on the 
toolbar to open the System, Group and User cfg files for this handset. 

3. In the Editable settings fields, enter information unique to the 
handset – Extension and IP address (if using static IP). Note that 
these two fields have a Next button that is useful for setting these 
fields when configuring a quantity of handsets.  

4. Copy the settings to the Phone settings fields using the Copy settings 
right arrow. 

5. Click Write Phone to begin the download.  
You may want to save the configuration, load new files or edit 
settings for the next handset (steps 1 and 2) during the download. 

6. (Conditional) If you wish to save the settings unique to this 
handset, enter the identifying information into the filename fields, 
such as user name or extension number and then click Save. 

7. When the Active flag turns off, the download has finished and the 
handset may be removed from the Cradle. 

Uploading a configuration plan from a handset 

1. Place a SpectraLink Wireless Telephone with the Battery Pack 
removed into the appropriate slot.  

2. Click the Read Phone button to begin the upload. 

3. When the Active flag turns off, the handset’s settings will appear in 
the Phone settings fields. 
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4. You may copy these settings over to the Editable settings fields 
using the Copy settings left arrow. The settings may be used to 
create configuration plans as described above, and may be saved 
by user or extension. 
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Software Maintenance 
The SpectraLink Configuration Cradle uses proprietary software 
programs written and maintained by Polycom. The software version 
can be displayed via the Help menu. 

Download the latest SpectraLink Configuration Cradle software from: 
http://www.polycom.com/usa/en/support/voice/wi-
fi/dual_charging_stand.html 

The software is delivered in a zip. Install the update by extracting the 
individual files from the zip and overwriting the existing 
PhoneConfig.exe and other files. 

Please follow customary backup procedures to preserve file integrity. 
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Assert Errors 
The Wireless Telephone displays the Assert Error message when it 
detects a system error from which it cannot recover. The assert error 
data is stored in flash memory until the handset is power cycled. This 
valuable information may be retrieved by the Configuration Cradle as 
an [.asrt] file and sent to Customer Service for further debugging. 

To record an assert error: 

1. Write down the error message on the display. 

2. Remove the Battery Pack and place handset in the Configuration 
Cradle while the Config program is running. 

3. Open the File menu, select Get Assert Information … 

4. Browse to where you want to save the .asrt file. 

5. Click Get Assert Data. The handset will upload the .asrt file to the 
specified location. 

6. Call Customer Service and arrange to email the file and error 
message from the display. 
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Regulatory Information 
This equipment has been tested and found to comply with the limits 
for a Class A digital device, pursuant to Part 15 of the FCC rules. 
Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause 
undesired operation. This equipment is intended for use in a Business 
environment.  

This Class A digital apparatus complies with Canadian ICES-003. 

 
This is a Class A product. In a domestic environment this product 
may cause radio interference in which case the user may be 
required to take adequate measures. 

Agency Approvals 

The following agency safety approvals apply to the Configuration 
Cradle: 

• EN 60950-1:2001 + A11 

• UL 60950-1:2003 

• CAN/CSA-C22.2  No. 60950-1-03 

• AS/NZS 60950-1:2003 

The following agency EMC approvals apply to the Configuration 
Cradle: 

• FCC Part 15, Subpart B:1999 

• Industry Canada Standard ICES-003 

• EN 55022:1994 + A1:2000/A2:2003 

• EN55024:1998 + A1:2001/A2:2003 
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Certification/Registration Numbers 
 
 

 

North 
America 

cTUVus 
Symbol 

 

CU 72050463 01  

Europe CE Mark 

 

US-TUVR-2236 CB Certification 

  AE 72051209 
0001 

Certificate of 
Conformity 
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Safety Notices 

Note concerning shielded cable 

Polycom recommends the use of a shielded cable for the external 
signal connection in order to maintain FCC Part 15 emissions 
requirements. 

 
Changes or modifications to this equipment not approved by 
Polycom may cause this equipment to not comply with Part 15 of 
the FCC rules and void the user’s authority to operate this 
equipment 

 

 
Polycom products contain no user-serviceable parts inside. Refer 
servicing to qualified service personnel 

Notes 

• The Configuration Cradle operates in a 50 to 85 degrees F (10 to 30 
degrees C) environment. Do not expose to freezing temperatures 
or sunlight. 

• Use only the original SpectraLink plug-in power adapter. 

• Place only one phone in the Cradle at a time. 

• Do not place a phone in the Cradle with a battery installed. 

• Do not immerse the Cradle in water or other liquid. 

• Do not pour liquids into the telephone slots. 

• Only use SpectraLink 8002, e340, h340, or i640 Wireless 
Telephones in this Cradle. 
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